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CMP/JMPS (Version 4.6.0.2)

Section 1

1 General Information

Section Objectives

After completing this section, you will be able to:

· Provide an overview of CMP/JMPS

· General knowledge of CMP/JMPS Installation requirements for DMS Users

1.1 Purpose

a. The purpose of this guide is to provide training in the use of the COE Message Processor (CMP)/Joint Message Processing System (JMPS) as it applies to the Defense Messaging System (DMS). It does not provide information pertaining to the use of CMP with legacy (Gateguard).

1.2 Overview

a. The CMP/JMPS provides the user with the capability to create formatted military messages.  The CMP/JMPS offers numerous user-friendly interfaces that allow the user to access the various capabilities.

b. The CMP/JMPS provides integrated message preparation with DMS and  helps users prepare, edit, validate and send formatted military messages to include (USMTF).

1.3 Installation

a. CMP/JMPS should be installed on the commands DMS Enabling Capability (EC) computer and may be installed on any workstation used to create outgoing messages for DMS transmission.

b. Installation software includes CMP/JMPS and Java and is usually accomplished by an Organization System Administrator.

Note: If a previous version of CMP is installed, it must be removed prior to installing CMP Version 4.6.0.2.

1.3.1 CMP/JMPS Installation

a. Insert the CMP 4.6.0.2 CD into computer CD reader.

b. Click on the Start button located in the lower left corner of the computer screen, then on Run.
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c. Using the Browse button, locate the file “cmp_4602_j2_disa.EXE”. Highlight the file name and insure it is present in the “File name” window, then click Open. The “Run” window will be displayed, click OK.
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d. The COE Welcome window will be displayed, click Next. The files will be extracted and the Welcome windows will be re-displayed, click Next.
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.

e. When the “Customer Information” screen is displayed fill in the User Name and Company Name, then click Next.  When the “Setup Type” window is displayed, choose DMS Mode and click Next. 
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Note: Selecting the DMS Mode will only install the items used to create JMPS messages for DMS messages. A complete install will also install this mode as well as all modes (Incoming and Outgoing) CMP is capable. A complete install will also use an excessive amount of hard drive space on the DMS EC.

f. Choose the default Program Folder by clicking Next on the “Select Program Folder” window is displayed. Click Next when the “Outlook Installation Directory” screen is displayed.
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g. When the “Start Copying Files” window is displayed, click Next. The CMP/JMPS files will be copied from the CD to the COE directory.
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JAVA Installation

a. After COE is installed, a “Question” screen will be displayed indicating the program is about to launch the Java2 Runtime setup. Click Yes.  A series of screens will be displayed showing the License Agreement (Click Yes) and the Setup status will be displayed. 

[image: image9.jpg]



b. When the “Setup Type” screen is displayed, choose “Typical” and click Next. The next screen will indicate “Creating Java JAR files”, and “Installation completed OK.”, then the “Choose Destination Location” window will be displayed. Click Next. 
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c. After the files have been transferred the “Installation Wizard Complete” window will be displayed. Choose “Yes” to restart the computer and click Finish and Finish.
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d. Three Icons will be created on your desktop. 
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1.4 Users Access to CMP/JMPS

a. CMP/JMPS is presently designed to work with administrator rights.

b. The following is a process to provide the rights just in CMP to the users.

· Go to the directory CMP is installed (e.g. c:\Program Files\COE Message Processor).

· Right Click on COE Message Processor and select Properties.

· In the properties folder, select Security, User and place a check in the “Allow” box for Full Control

· Click Apply and OK.

Section 2

2 CMP Administrative Tool

Section Objectives

After completing this section, you will be able to:

· Setup the CMP Administrative Tool for DMS
a. The CMP Admin Tool is a system administration tool that allows the CMP application to be configured based on unique user requirements.

2.1 Starting CMP Admin Tool

a. Double click on the “CMP Start Admin” icon that was created on the desktop during installation of CMP. A window will be displayed indicating the tool is starting.
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2.1.1 Message Prep Tab

a. The CMP Admin Tool, Message Prep Tab screen will be displayed.  The “Automatic Dash Insertion” section places a dash in all fields that are empty and mandatory and all empty fields that precede a non-empty field. Un-checking these fields will eliminate dashes in any field.
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b. The Validate Settings section allows for the choice of lower or upper case characters, check for illegal characters as the user types in each field and validate cases and conditions.
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c. The DMS section allows for the inclusion of the classification in the message. Since DMS 3.0 does not add the classification to the message until the MS Outlook Send button is clicked, we DO NOT check this option.
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d. The originator option allows the operator to type his/her command name in the window provided. The name typed in the window will be displayed out all outgoing messages.
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Custom Template Maker

a. The operator can select a message template and turn off the fields in that message that may not be required. Only optional and conditional fields can be cut off.

b. Click on the Custom Template Maker button. The Custom Template Maker screen will be displayed. Click on File and then New Template to display a list of templates.
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c. Click on the column labeled “Message ID” to place Message names in alphabetical order, move the slider on the right to locate the template you wish to change (In this case we select GENADMIN) and click OK. 
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d. The edit screen will be displayed. Highlight the Optional or Conditional Set you wish to toggle and right click on the Set. A “Toggle On/Off window will be displayed. Clicking on the Toggle will either turn the Set off or on depending on it original state. Mandatory Sets CAN NOT BE TURNED OFF. Select the File, Exit to save the template. We will select No to save the template in class.
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e. Select the File, Exit to save the template. We will select No to save the template in class.
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Outbound Tab

a. Click on the “Outbound” Tab. Under the “Send Message Options” choose Send no invalid messages. Under the “Warning Options for Send” choose Warnings for all invalid messages. 
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2.1.1.1 Select Preferred Messages

a. The operator can select the message formats most frequently generated by clicking on the Select Preferred Messages button.
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b. To create an entirely new Preferred Messages list, remove all messages in the “Preferred Messages” section by highlighting the first message. Hold the shift key and click on the last message (This will highlight all of the messages). Click the REMOVE button to remove all highlighted messages.
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c. In the top portion of the screen, clicking on the column heading “Message ID” will place that column in alphabetical order. Using the slider on the right, locate and highlight desired message Templates from the Baseline Messages Table (In this case “GENADMIN” ) and click to highlight.
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d. Click the APPEND button.  This will initially populate the Preferred Messages List with the chosen message Template.  
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e. Multiple templates can be added to the Preferred Messages section by highlighting all the desired templates and then clicking on the APPEND button. Use the APPEND/ INSERT/MOVE/MOVE TO keys to modify as desired. Click OK to save changes. 
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f. When the Outbound tab is again displayed, click OK to exit the Administrative Tool.
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Section 3

3 Joint Message Preparation System (JMPS)

Section Objectives

After completing this section, you will be able to:

 - Setup the CMP Administrative Tool for DMS


- Understand the JMPS Icon Bar
 - Open JMPS from the Desktop




- Understand the JMPS GENADMIN Message Template

 - Open JMPS from DMS Outlook




- Create a JMPS GENADMIN Message

 - Open an existing JMPS message



- Save a completed JMPS message

 - Configure JMPS






- Move a JMPS message to DMS Outlook

3.1 Opening JMPS From the Desktop

a. To create an outgoing message CMP uses the Joint Message Preparation System (JMPS). Access to the JMPS program can be from the desktop Icon or from Outlook.

b. To access JMPS from the desktop, click on the “CMP Start JMPS” Icon.
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3.2 Opening JMPS From Outlook

a. To access JMPS from Outlook, open Outlook, and then click on the “New” button to bring up the New Mail Message form.  Insure your curser is in the message body portion of the form. If it is not, the message will not be moved to the body of the form when it is completed. Click on the JMP icon. A “Notice” window will be displayed. Make sure your curser is in the body of the message form and click OK. JMPS will start.
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3.2.1 Opening an Outgoing Message Template

a. The “Select Message Template” window will automatically be displayed. Highlight the appropriate “Message ID” (Type of message, in this case GENADMIN) and click OK. If the message type is not displayed, click on More>> and select the message type from the list.

Note: The Message names/ID listed on this screen were determined during the CMP Admin Tool setup. This is the may be changed by accessing the CMP Admin Tool and selecting the “Outgoing” tab. Clicking on the “Select Preferred Messages” button will allow the operator to change the template list.
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b. The message template screen will be displayed. The drop-down menus and the Icon bar are located on the top portion of the screen. The lower portion of the screen contains the message template. 
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 JMPS Configuration

a. Click on the Config drop down menu option, and then click on Settings. The “Configuration Settings” window will be displayed. Select desired options. This example shows the options used on the training computers. Click on OK when finished.
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JMPS Icon Bar

a. Icons become available when various choices are made while filling out a message.  Some important icons are listed below:
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Open a new message.
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Open a message from a file.
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Preview the current message.
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Duplicate the current selection (Used to Repeat fields).
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Insert a set in the current segment, after the selected set (Includes AMPN, NARR and RMKS). When REF or POC sets are selected, can be used to add additional REF or POC Sets.
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Compress the current message (Removes all non-mandatory empty sets).
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Clear the contents of all fields.
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Verify the current message body. A check to insure all mandatory data has been entered.
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Expand field into coded elements. Provides operator with a drop down arrow which displays all the codes used in the selected field.
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Close coded field.
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Displays additional segments
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Displays set information.
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Displays field information.

[image: image49.png]Flo Edt Verty View Config Holp
3] [ [ () () [ ][] ] [ ) ) =] mna] ][]
CENADMIN
0 bR per /
- ER—
M MSGID !
M 5U8)
Y oo [oEnsommisTUDERTI0!
0 Poc
0 AKNLDG sUBJ !
M GENTEXT
0 DEcL = /b ] msop [mapum /
¢ <
P v
<
Fos /
K56 /
[GENTEXT | =
= /
<] [ D
[REFERENCE

JoRIGINATOR = [





Displays the definitions of the items in the coded list.

JMPS Message Template

a. The left side of the lower screen displays the “Sets” available in the template.  The letters to the left of the set name indicate O for Optional, C for Conditional and M for Mandatory. Mandatory sets appear in Red, Optional sets are in Green and Conditional are in Yellow. Note, in the MSGID set the originator of the message is automatically placed next to the GENADMIN. This was accomplished when setting up the Admin Tool, in the “Message Prep” tab, under the DMS, Originator window.

b. To open and add information to a set, click on the appropriate set bar name.
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3.2.2 Reference Set

a. The reference set contains most of the elements used in JMPS. To open the Reference set, click on the REF set bar in the left side of the template. Whenever a set is opened, the bottom line of the screen describes what information is required and how many characters can be placed in the field. In the first field of the Reference set, the lines indicate the field is for a Serial Identifier, A, B-Z or AA, AB-ZZ.
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b. On the Icon bar, the Set Icon is available. Click on the Set Icon to display the Set Information. In this case the information shows the REF set is set 5, there is one occurrence (if there were additional Ref sets, the information window would indicate the number of each occurrence), the type is Operational and it is a Repeatable set (the set can be repeated as often as needed).
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c. To repeat the Set, right click on the set name and a window will be displayed, click on Insert Set… and the “Insert Set” window will be displayed. Click on REF and click OK. This will add an additional Ref Set.
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d. On the Icon bar, the ‘Field’ Icon is available. Click on the fld Icon to display the field Information. The Allowable Values are indicated as well as Additional Information needed to complete the field. Click OK.
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e. Type the letter “A” in the first field (Indicating the first reference) and press the tab button to move to the next field. Notice the thin lines around each field changes color, some to Red meaning the field is Mandatory and some to Green meaning Optional. Only the fields bordered in Red require data.
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f. Tab or click on the next field. Click on the fld Icon to display what information is required in the field. Notice the “Alternate” field is “Yes”.  Click OK to close the field window. 
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g. To choose an alternate field, right click on the field to display an options window. Click on Modify Field Alternate and a “Select Alternate Fields” window will be displayed. 
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h. The operator can choose to use a “MESSAGE TEXT FORMAT IDENTIFIER” or “REFERENCE DESCRIPTION”. 

i. MESSAGE TEXT FORMAT IDENTIFIER is used when referencing a message. Use the USMTF ID, such as GENADMIN, CASREPT etc. When selecting the MESSAGE TEXT FORMAT IDENTIFIER the field is prefaced with MSGID: Click on “MESSAGE TEXT FORMAT IDENTIFIER” in the “Select Alternate Fields” and click OK.  Click on the fld icon to see the field information. Click OK when finished.
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j. REFERENCE DESCRIPTION is used when referring to a document, phone conversation etc. When selecting the REFERENCE DESCRIPTION the field is prefaced with DESC: Click on “REFERENCE DESCRIPTION” in the “Select Alternate Fields” and click OK.  Click on the fld icon to see the field information. Click OK when finished.
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k. We will refer to a message from CNO WASHINGTON DC. Right click on field 2 and select “MESSAGE TEXT FORMAT IDENTIFIER” and click OK. Type GENADMIN in the field 2 blank.
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l. Tab to the next field. With the curser in field 3, click on the fld Icon to display the Field Information for this field. Field 3 is for the Originator of the message or correspondence you are referring to. Type CNO WASHINGTON DC in field 3.
[image: image61.png]cut
Cony
Paste

Insert Set,

Close Field

Moty Feld Alternate...





m. Tab or click your mouse in the next field. Since we are referring to a message, right click on field 4 and click on Modify Field Alternate. When the “Select Alternate Fields” window is displayed, highlight “REFERENCE DATE-TIME GROUP” and click OK.
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n. The field changes to allow the operator to place a Date-Time-Group (DTG) in the field.
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o. The curser will be located in the first block; click on the fld Icon to obtain a description of what information should be placed in the block. Each block is listed as an Occurrence.  Occurrence 1 is for the Day (Type 01), Occurrence 2 is for the Hour (Type 12) and Occurrence 3 is for the minutes (Type 00). Press the Tab Key or move the curser to the next field.
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p. The fourth Occurrence block has a drop-down arrow. Click on the fld Icon and it will display the Field Information for the “Time Zone”, Occurrence 4. Click on the drop-down arrow and move the slider down until you can see the “Z”, click on the “Z” to add the Zulu time zone to the DTG. Press the Tab Key move the curser to the next field.
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q. The fifth Occurrence block is also a drop-down. Click on the fld Icon and it will display the Field Information for the “Month Name”, Occurrence 5. Click on the drop-down arrow and click on “JUN” to select the month of June. Press the Tab Key or move the curser to the next field.
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r. Click on the fld Icon and it will display the Field Information for the “Year”, Occurrence 6. Type 2004 in the block. Press the Tab Key or move the curser to the next field.
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s. The remaining fields are optional as indicated by the Green border. Click on each field and then click on the fld Icon to display the Field Information.
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3.2.3 POC Set
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To open the POC (Point of Contact) set, click on the POC Set Bar in the left side of the template. Click on the fld Icon each time you change fields to view the Field Information window describing the required contents of the field. The first field is the Point of Contacts Name. Type your name and press the Tab Key or move the curser to the next field.

b. Field 2 is used for the “RANK OR POSITION”. Type your Military Rank, Government Service Grade or Civilian (Or any description desired) in the field. Press the Tab Key or move the curser to the next field.
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c. Field 3 defaults to Call Sign. Right click on field 3 and select “Modify Field Alternate” and highlight Unit Identifier.  Type your Commands name or UIC in this block.  Press the Tab Key or move the curser to the next field.
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d. Field 4 defaults to a Lat/Long location. To change the field to Location, right click on the field and select Modify Field Alternate then click on Location and then OK. Type your commands location and press the Tab Key or move the curser to the next field.
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e. Field 5 is used to record contact information such as Email addresses and Telephone numbers of the POC. To change the field to Email address, right click on field 5 and click on “Modify Field Alternate”. When the Select Alternate Fields window is displayed, highlight “Electronic Mail Address” and click OK. Type your Email address in the field.
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f. Field 5 is a repeatable field. To add additional contact information, right click on the field and click on Duplicate Selection. This will provide an additional window to record data. Tab or move the curser to the new field.
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Note: An alternate method of duplicating a section is to use The “Duplicate the Current Section” Icon. When this icon is Available, place the curser in the field you wish to duplicate And click on the Icon. An additional section will be added.

g. Right click on the new field and click on Modify Field Alternate, then choose an alternate type of field such as NONSECURE TELEPHONE NUMBER. Click OK.
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h. Complete the additional fields with the desired information. Add additional fields as needed. 
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MSGID Set

a. To open the MSGID set, click on the MSGID Set Bar. Using the fld Icon, field 1 is the “Message Text Format Identifier” MSGID and requires no action by the operator. Field 2 is the message originator and is automatically filled in. The remaining 4 fields (Message Serial Number, Month Name, Qualifier and Serial Number of Qualifier) are optional. Fill in as necessary.
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b. The remaining 4 fields (Message Serial Number, Month Name, Qualifier and Serial Number of Qualifier) are optional. Fill in as necessary. 
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3.2.4 SUBJ Set

a. To open the MSGID set, click on the SUBJ Set Bar. The fld Icon displays the Field Information for the subject. The mandatory field 1 permits 64 characters. Type CMP TEST MESSAGE 001 in field 1. If additional space is required, field 2 allows for an additional 68 characters. Field 2 is repeatable if additional space is needed. 
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3.2.5 GENTEXT REMARKS

a. To open the Remarks set, click on the GENTEXT Bar. Field 2 is a free text field with no limit to the quantity of text. The operator may enter Data either by typing the information or using the Cut and Paste functions of Windows.
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Cut and Paste Remarks

a. A text file has been created on the student computers hard drive and is located at D:\CMP\Cut_Paste Data\Test Message Remarks.txt.

b. Locate the file by clicking on the START button in the lower left corner of the lab desktop.  Click on Programs, Accessories and Windows Explorer. This will bring up Windows Explorer. 
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c. In Windows Explorer, click on the plus sign to the right of “student#” folder. Click on the plus sign to the left of “Local Disk (C:)” and click on the folder titles “CMP Cut_Paste”. This will reveal a file titled “CMP Cut_Paste.rtf”. Double click on the file name to open the file in WordPad.
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d. Highlight all the text by pressing the ctrl key and the Letter A key or use the mouse to highlight the information. Press the ctrl key and the Letter C key or click on the Copy Icon. This will place the data on the computer clipboard and make it available to CMP. 
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e. Click File and Exit to close WordPad.
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f. Click on File then Close to close Windows Explorer.
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g. Click on the CMP Icon bar click on the Insert Clipboard contents Icon. Or on the CMP Edit drop down menu, then on Paste. 
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h. This will place the copied text into the Remarks field of CMP. Add additional information as required.  
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Preview The Message

a. To preview the message, click on “Preview the current message icon. Review the message and then click OK.
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3.2.6 Verify The Message

a. To verify all the required sets have been completed, click on the Verify the current message body Icon. A notice will be displayed if CMP detects any mandatory sets have not been completed. If all sets have been completed correctly a “Message Body is Valid” screen will be displayed. Click OK.
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Compress The Message

a. Compressing the message removes all the unused sets and leaves only those sets that have be successfully completed. Click on the Compress the Current Message Icon. A JMPS message window will be displayed asking if you wish to continue the operation, click Yes.

[image: image93.png]



b. The message will be compressed.
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Add Additional Sets

a. Additional AMPN, NARR, RMKS and DECL Sets may be added if required by right clicking on a Set Bar. Click on Insert Set and choose which Set you wish to insert. The additional set will be inserted following the Set Bar.

[image: image95.png]



3.2.7 Saving the Message

a. To save the message, click on the File drop-down menu then click on Save As. The “Save As” window will be displayed. Choose the appropriate folder ( “Outgoing Messages” on the “C” drive) to save the message in and type the name of the file in the “File name” window (CMPTEST001.cmp). Be sure you include the file extension .cmp. Click Save.
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3.2.8 Closing JMPS

a. To close JMPS, click on File, then on Exit. Do Not Close the Message at this time.

[image: image97.png]



SECTION 4

4 Moving a JMPS Message to Outlook

4.1 Opening a JMPS Prepared Message in DMS Outlook

a. After a message has been approved for transmission, provide the message to the DMS operator by whatever method your command uses.

b. The DMS operator will open DMS Outlook, Open a New Mail Message Form and bring up CMP. Note: Ensure your curser is in the DMS message BODY before enabling CMP.

c. To open an existing message, click on the Open button on the “Select Message Template”.  When the “Open Message File” window is displayed locate the message you wish to open, highlight the file name and clock Open. This will bring the message into JMPS.
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d. After the message has opened in JMPS, it can be moved into Outlook by clicking the “Send to DMS” button in the upper left side of the JMPS screen. This button will only be active if you entered JMPS via Outlook.  
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e. After the message is moved to the Outlook New Mail Message form body, address the message, enter the appropriate Elements of Service and send the message.
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SECTION 5

5 DMS BUSINESS UTILITY

Section Objectives

After completing this section, you will be able to:

· Understand the need for DBU

· Understand the DBU Process

· Open and Set-up DBU

· Use DBU to Process and Outgoing Message

5.1 Overview 
a. The DMS Business Utility 2 (DBU-2) product has been designed to provide a Commercial Outlook 2000 (O2K) client the ability to generate a message that a DMS 3.0 Client (User Agent) (UA) can open, modify, and send. 

b. When using DMS 2.2, the O2K forms used for outgoing messages were compatible with the DMS 2.2 forms.

c. DMS 3.0 allows the use of custom forms, which DMS 2.2 did not. Therefore, under the current scenario, when the DMS Client opens a message drafted by an O2K client, it will either be blank or missing required lines. This is due to compatibility issues between DMS 2.2 and DMS 3.0 forms. 

d. DBU-2 solves this issue by inserting the data from an O2K message into a DMS 3.0 form. 

e. The drafter will use a workstation with a minimum of 02K and MasterKeyPlus installed. MasterKeyPlus standalone can be downloaded from the website: https://dms.navy.mil 

f. DMS 3.0 EC will include an operational DMS 3.0 Client, CMP and DMDS prior to the installation of the DBU-2 software.

g. If the command does not have the EC connected to the LAN, released messages can be copied to a floppy disk and taken by hand (Sneaker Net) to the DMS EC and placed in a folder on the Hard drive.

h. The figure below represents a general configuration for DBU-2 with an EC connected to the Command LAN.
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i. The figure below represents a general configuration for DBU-2 with a EC NOT connected to the Command LAN
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5.2 Process
a. Several folders must be created on the command LAN Server. One folder (Draft) is used to hold outgoing messages while the Drafting Officer and others review them in the Command Chop chain. Once the Releasing Authority has authorized the message to be transmitted, it is placed in the other folder (Release).

b. An outgoing message is prepared on a Commercial O2K computer. This computer has MasterKeyPlus stand alone software installed and directed at the appropriate IP address for the Primary DSA. This computer must be connected to the command LAN and have access to the Internet.

c. In addition to the message text and addressees, the drafter must indicate the Elements of Service (EOS) that are not available in Commercial Outlook such as the message precedence, classification and code words as necessary. This information will be used by the Releaser to assign the EOS information to the message when it is converted into the DMS message form, and can be in the form of a text file attachment.

d. The message is transferred from CMP to Outlook.

e. The Drafter inserts the subject and addresses the message using MasterKeyPlus with either V3 Distinguished Names (DN) or AUTODIN PLA’s retrieved from the Directory User Agent (DUA) and attaches a text file with EOS information.

f. The message is saved as either an .oft or .msg file and placed in the file server “Draft” folder created on the Command LAN Server.

g. Command policy will dictate who must review the message.

h. The message is reviewed by the Releasing Authority and placed in the file server “Release” folder created on the Command LAN Server.

i. If the EC is connected to the command LAN and DBU-2 is activated DBU-2 scans the “Release” folder, moves the message to the DMS Outlook Mailbox “Draft” folder.

j. If the EC is not connected to the command LAN, the message authorized to release must be placed on a transportable median (such as a floppy disk), and taken to the DMS operator. The DMS EC should have a folder created where the message is placed in order for DBU-2 to scan and moved to the DMS Outlook Mailbox “Draft” folder.

k. The Releaser opens the message in the “Draft” folder, Clicks on the Convert button to convert to a DMS 3.0 Outgoing Message Template.

l. The Releaser opens any text attachments to obtain EOS information, deletes the attachment, completes the required military properties and transmits the message.

5.3 Log on to DMS Outlook
a. After logging on to the DMS DSP, Log into DMS Outlook by clicking on the Microsoft Outlook Icon. When the DMS window is displayed click on the Agree button.
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b. The DMS Outlook screen will be displayed.
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5.4 Open DBU-2
a. Double Click on the DBU-2 Icon to open the program
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5.5 Set-up DBU-2
5.5.1 Set Type Of Alert
a. When the DBU-2 window is displayed, click on the Options drop-down menu, highlight Alert and select the alert desired. Play Sound plays a selected .wav file sound when a message is placed in the Mailbox Draft folder.
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b. When Show “Draft Dialog” is selected a full screen window is displayed, indicating the number of messages placed in the Mailbox Draft folder.
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c. When Show “Tray Popup” is selected a popup window is displayed, indicating the number of messages placed in the Mailbox Draft folder.
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5.5.2 Set Source Folder
a. Click on the Options drop-down menu and highlight and click on Set Source Folder. Locate the Share “Release” folder and click OK. You may also use the Add button to select a source folder. 
[image: image157.png]



b. The number to the left of “Folder” indicates how many folders are to be searched.
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5.6 Using DBU-2
5.6.1 Message Preparation
a. After a message has been prepared in CMP, forwarded to the Drafting Officer and then to the Releasing Officer, the released message will be provided to the DMS EC operator.

1. If the command does not have the EC connected to the command LAN, the message can be placed on a floppy disk and taken to the DMS EC and copied into the “Release” folder located on the EC.

2. If the command has connected the EC to the command LAN, the message can be placed into a share “Release” folder, which can be either a local folder, a network shared folder, or a mapped drive.

5.6.2 Retrieving and Sending a Released Message
a. Open DMS Outlook.

b. Activate DBU-2 by clicking on the DBU-2 Icon.

c. Start the DBU-2 scans by clicking on the Start Scan button. The DBU-2 log will begin recording actions taken by DBU-2. The designated folder(s) will be scanned. If there is a message(s) in the folder, the log will record the file name, DBU-2 will create a back up file (.bak) and place the message(s) in the DMS Outlook mailbox  “Draft” folder. The alert selected will be displayed.
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d. In DMS Outlook there will be a message(s) in the Drafts folder. Double click on a message.
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e. When the message is opened, notice the template is the commercial O2K template. To convert to the DMS 3.0 Template, click on the Convert button.
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f. This will convert the O2K message template to the DMS Outlook New Mail Message Template. The following Elements of Service are part of the converted message: 

· The TO: information. 

· The CC: information. 

· The Bcc: information. 

· The SUBJECT information. 

· The BODY 

· Any attachments. 
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g. Attachments can be used to convey the Precedence, Classification and any Code Words the DMS EC operator will need to complete the message. The DMS operator can open the attachment, set the appropriate military properties and delete the attachment.
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h. The Releaser must accomplish the following prior to sending the message:

· Select the Primary and Secondary Precedence.

· Select the Message Type (Other – Organizational).

· Select the DTG using the Military Tab.

· Select the receipts/delivery notices desired using the Recipients tab.

· Select any additional military properties required.

· Select Fortezza Role.

· Send the message

i. If the classification was included in the message, the Releaser must delete it from the text because DMS 3.0 inserts the classification during the transmission process.
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j. After the message is cleaned up and the EOS are selected, send the message.
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Stop DBU-2 Scanning
a. To stop the DBU-2 scanning process, click on the Stop scan button. A DBU-2 window will be displayed asking if you wish to stop scanning. Click  Yes and the program will stop scanning the folder(s).
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5.6.3 Archiving the DBU-2 Log
a. To Archive the DBU-2 log, click on the File drop-down menu and click on Archive Log. A DBU-2 window will be displayed showing the location of the archived file and name.
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5.6.4 Clearing the DBU-2 Log
a. To clear the log, click on the File drop-down menu and click on Clear Log. This will clear the information shown on the log.
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5.6.5 Closing DBU-2
a. To close the DBU-2 program, click on the File drop-down menu and Exit. A DBU-2 window will be displayed asking if you really want to exit the application. Click Yes.
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